1 Synopsis
IMG supports MyIMG and missing gene annotations for users to add or update existing gene

information and to facilitate community annotations.

MylIMG and Missing Gene Annotations requires a login and password which can be
requested by filling the Request Account form at: http://img.jgi.doe.gov/request.

In order to view, add, or modify MyIMG or missing gene annotations, a user should first log into
IMG ER to find the Annotations menu item under the MylIMG tab (Figure 1.1):

IMG User Annotations

You can view annotations, or upload annotations from flat files.

View Annotations

@ View all annotations
View annotations by genomes

View annotations for all genes in gene cart

View My Annotations View Group Annotations

Upload Annotations from File

Upload your own annotations from a tab-delimited file.

Upload Annotations

View My Missing Gene Annotations

View My Missing Genes View Group Missing Genes

Figure 1.1: IMG User Annotations
There are 3 sections on this page:

o View Annotations: view, add, or update user's MyIMG annotations. There is also a
"View Group Annotations" button if the user belongs to an IMG group.

o Upload Annotations from File: update MyIMG annotations from a tab-delimited file.

o View My Missing Gene Annotations: view, add, or update user's missing gene
annotations. There is also a "View Group Missing Genes" button if the user belongs to
an IMG group.

2 MyIMG Curation of Functional Annotations



The functional annotation for individual genes can be curated using the MyI[MG Annotations
features of MyIMG. In addition to curation of functional annotations, MylIMG provides support for
uploading user genome selections that have been saved earlier from Genome Browser or
Genome Statistics and set system wide user preferences.

MyIMG Annotations provides support for: (1) editing the product name and several associated
fields for one or more related genes that have been previously selected and saved in the Gene
Cart; (2) finding genes associated with enzymes missing in specific genomes; (3) reviewing
the functional annotations for individual genes or group of genes; (4) associating genes with
additional IMG terms; (5) marking genes obsolete; (6) exporting to/ uploading from a tab-
delimited file functional annotations for genes identified by their IMG identifier (OID).

2.1 Editing Product Names

Genes that may require product name review and curation can be identified using various
analysis tools. For example, genes without a product name but with evidence of potential
functional annotation or with product name but without any evidence of functional annotation
are candidates for product name review and curation.

MyIMG provides support for editing the product name and associated information for one or
several related genes. The following annotation fields can be manually edited:

e Product Name

e Protein Description
e EC Number

¢ PUBMED ID

e Inference

e |s Pseudo Gene?
e Notes

e Gene Symbol

First, select and save the target genes for product name curation in the Gene Cart. Next, use
the Annotate Selected Genes link in the MyIMG Annotation section of the Gene Cart to
access the tool that allows editing the fields listed above.

Example 2.1. Consider for review gene PF1186 (IMG identifier 638173757) of genome
Pyrococcus furiosus whose details are shown in Figure 2.1(i). This gene is associated with
product name NADH oxidase, as shown in Figure 2.1(i), and as recorded in GenBank and
RefSeq which can be viewed by following the appropriate External Links. The list of top
homologs for the gene under review can be displayed display via the Homologs section of its
Gene Details, as shown in Figure 2.1(ii).
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Figure 2.1. Review and curation of the product name for a gene of Pyrococcus furiosus using

MyIMG Annotation.

Based on a recent study’, it has been determined that the function for this gene is NADPH:sulfur
oxidoreductase, and an expert review of the best homologs of this gene indicated that this
product name also may be confidently applied to the top three homologs. The gene under
review and these top homologs are added to the Gene Cart, as shown in Figure 2.1(iii).

Next, the product name where is changed to NADPH:sulfur oxidoreductase using the MyIMG
Annotation tool accessed from Gene Cart, as shown in Figure 2.1(iv). Other annotations (e.qg.,
EC number) can be also modified. User annotations are stored in IMG and can be reviewed at
any time using MyIMG viewing options, as shown in Figure 2.2.

' Schut, G.J., Bridger, S.L., Adams, M.W. (2007) Insights into the metabolism of elemental sulfur by the
hyperthermophilic archaeon pyrococcus furiosus: characterization of a coenzyme a-dependent NAD(P)H
Sulfur Oxidoreductase. Journal of Bacteriology.



2.2 Finding Missing Enzymes

The metabolic capacity of a genome is defined by its association with pathways via gene
products that function as enzymes serving as catalysts for reactions in these pathways. A
genome-pathway association may be partial, with “missing” associations between enzymes for
reactions on the pathway with genes on the genome. We call such associations missing
enzymes.

2.2.1 Missing Enzymes for Specific Genomes and Genes

MyIMG provides support for revising missing enzymes for specific genomes and genes. For
each genome, the Genome Statistics section of its Organism Details page contains a count of
“Genes without enzymes, but with PRIAM hits” which leads to a list of genes that could be
associated with enzymes predicted by PRIAM. These predicted enzymes can be examined for
accuracy and then associated with genes using MylIMG Annotation tools.

Example 2.2. Use the Genome Browser for selecting Thermoplasma volcanium GSS1 (T.
volcanium) genome and examine the Genome Statistics section of its Organism Details, as
shown in Figure 2.2(i). Follow the “Genes w/o enzymes but with candidate KO based enzymes”
link to the list of genes that have candidate KO based enzymes, as shown in Figure 2.2(ii).
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Figure 2.2. Examining Missing Enzymes for a Specific Genome.



Select the genes you want to associate with the predicted enzymes and then use Update
MyIMG Annotation, as shown in Figure 2.2(ii). You can either Add the predicted enzyme to or
Replace an existing enzyme in your MyIMG annotation. The new gene-enzyme associations
are listed for review, as shown in Figure 2.2(iii).

Instead of associating lists of genes with the candidate KO based enzymes, one can examine
all enzyme predictions for individual genes via Find Candidate Enzymes with PRIAM available
in the Gene Information section of the gene’s Gene Detail page, as illustrated in Figure 2.3(i).

Example 2.3. In the list of genes of Thermoplasma volcanium GSS1 (T. volcanium) genome
that have candidate KO based enzymes (see Figure 2.2 (ii) go to the Gene Detail page for the
gene with IMG identifier 638191966. Use Find Candidate Enzymes immediately before the
Find Candidate Product Name section, as shown in Figure 2.3(i), to get to the list predicted
genes on the Candidate Enzymes Using Kegg Ontology (KO) page, as shown in Figure
2.3(ii). Examine the enzymes in the list and select the best predicted enzyme(s). Use Add to
MyIMG Annotation, as shown in Figure 2.3(ii), and then either select Add or Replace, as
shown in Figure 2.3(iii), to update the MyIMG enzyme annotation for this gene.
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Figure 2.3. Examining Missing Enzymes for a Specific Gene.

2.2.2 Missing Enzymes within a KEGG Pathway or Function Profile



MyIMG provides support for examining missing enzymes for a specific genome, G, using
either a KEGG Pathway Map for G or a Functional Profile involving G and enzymes of
interest, as illustrated in Figure 2.4.

Example 2.4. Use the Genome Browser for selecting Thermoplasma volcanium GSS1 (T.
volcanium) and Thermoplasma acidophilum DSM 1728 (T. acidophilum) genomes. Save these
selections. Select Find Functions in the Main Menu and then select the KEGG browser and
Pathways via EC Numbers submenu item, as illustrated in Figure 2.4(i). Selecting the Fatty
acid metabolism pathway under Lipid Metabolism will lead to the KEGG Pathway Details
page for this pathway, as shown in Figure 2.4(ii). You can either:

(i) Select the View Map for Selected Genomes tab, and then select T. volcanium and
"Find missing enzymes" option, and click View Map at the bottom of the KEGG
Pathway Details to display the KEGG map for the Fatty Acid metabolism pathway, as
shown in Figure 2.4(iii), or

(i) Select enzymes of interest from the list of enzymes (e.g., EC:1.3.3.6, EC:1.3.99.3, and
EC:6.2.1.3) provided by the KEGG Pathway Details, save them in Function Cart, and
compute a Function Profile for these enzymes across T. volcanium and T. acidophilum
which will result in the profile shown in Figure 2.4(iv).
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Figure 2.4. Examining Missing Enzymes with KEGG Pathway Map and Function Profile.

On the KEGG Map, enzymes that are associated with a T. volcanium gene are colored blue,
enzymes that are associated with any T. volcanium MyIMG gene annotations are colored cyan,
while so called “missing” enzyme are colored either green, for enzymes that have candidate
enzymes with KO hits to a T. volcanium gene, or yellow, for enzymes without any KO hits to T.
volcanium genes. Clicking on a missing enzyme such as EC:6.2.1.3, as illustrated in Figure
2.5(i), will lead to a Find Candidate Genes for Missing Function page, as shown in Figure
2.5(jii). Note that selection of a (green colored) missing enzyme that has a KO hit enhances the
chances of finding for it good candidate genes.

In the Function Profile result, enzymes that are associated with T. volcanium or T. acidophilum
genes are identified by positive integer numbers which represent the count of genes associated
with the enzymes, while so called “missing” enzyme are identified by a “0”.

For missing enzymes of interest, MylIMG provides support for finding candidate genes that
could be associated with these enzymes, as illustrated in Figures 2.3 and 2.4.

Example 2.5. Consider “missing” enzyme EC:6.2.1.3 identified as discussed in Example 2.4
above, and leading to Find Candidate Genes for Missing Function page, as shown in Figure
2.5(iii).
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Figure 2.5. Finding Candidate Genes for Missing Enzymes on a KEGG Pathway Map using
Homologs.



You can find candidate genes of T. volcanium that could be associated with this enzyme as
follows:

(i)

Search for T. volcanium genes that have homologs/orthologs associated with enzyme
EC:6.2.1.3, as illustrated in Figure 2.5(iii). You can search across all the genomes available
in the system, across a subset of genomes within a certain domain/phyla/class, or only
across the selected genomes (i.e. T. acidophilum). If you have started from a Function
Profile, you can also restrict the search to the genomes involved in the profile. You can
change the default values set for percent identity and e-value cutoffs and the number of
retrieved homologs. The result of this search lists T. volcanium candidate genes, as
illustrated in Figure 2.5(iv). You can select a candidate gene and associate it with the
“missing” enzyme using the MylIMG Annotation tool.

Employ KO for finding T. volcanium genes that could be associated with the “missing”
enzyme, as illustrated in Figure 2.6(ii). You can change the default values set for percent
identity, e-value, and percent alignment cutoffs.

The result of this search lists T. volcanium candidate genes, as illustrated in Figure 2.6(iii).
You can select a candidate gene and associate it with the “missing” enzyme using the
MyIMG Annotation tool.
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Figure 2.6. Finding Candidate Genes for Missing Enzymes on a KEGG Pathway Map using
KO.



(iii) Employ a combination of homolog/ortholog based search and KO, which will list the
results together.

From the list of candidate genes (e.g., see Figure 2.6(iv)), you can select a candidate gene and
go to the Add Enzyme to Candidate Gene(s) in MyIMG Annotation tool shown in Figure
2.7(i). You can either add or replace the “missing” enzyme for the selected candidate gene.
After the addition of MyIMG annotation, KEGG Map display will show enzyme EC:6.2.1.3 being
color cyan instead of the original green (Figure 2.7 (ii)). Gene Detail of gene 638190626
(TVG0135483) page will display the new MyIMG annotation (Figure 2.7(iii)).
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Figure 2.7. Associating a Candidate Gene with an Enzyme using MyIMG Annotation.



2.3 Reviewing MyIMG Annotations

MyIMG annotations for all the genes that you have curated can be reviewed using the View My
Annotations section of the IMG User Annotations page. This page can be accessed using the
Annotations sub-menu of the MylIMG main menu tab, as illustrated in Figure 2.8(i). Three
review alternatives are available:

(i) All the genes can be displayed in a tabular format, where each row consists of the
annotations for an individual gene, as illustrated in Figure 2.8(ii).

(i) The genes are first displayed grouped per genomes, as illustrated in Figure 2.8(iii). You
can select the list of genes for a specific genome to review their annotations.

(iii) Display is limited to only genes in gene cart.
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Figure 2.8. View MylMG Annotations.
The page displaying MylMG Annotations for curated genes provides support for uploading
annotations to a tab-delimited file using Upload Annotations (see Figure 2.8(i)). The file has

the following column headers:

e Gene ID or OID (required): gene object ID
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e Annotated Product Name (required): my annotated product name(s); separate multiple
product names using "'

o Annotated Prot Desc (optional): my annotated prot description

e Annotated EC Number (optional): my annotated EC number(s); separate multiple EC
numbers using space or";'

¢ Annotated PUBMED ID (optional): my annotated PUBMED ID(s); separate multiple

PUBMED ID's using space or "'

Inference (optional): my annotated inference

Is Pseudo Gene? (optional): is pseudo gene? (Yes, No)

Notes (optional): my annotated free text notes

Annotated Gene Symbol (optional): my annotated gene symbol

Remove Gene from Genome? (optional): remove gene from genome? (Yes, No)

2.4 Group and Community Annotations

If a user belongs to an IMG group, then the user can view all MyIMG annotations by group
members with the following restrictions:

e The user must have access permission to the genomes. All MyIMG annotations on
private genomes will only be visible to other group members that have access
permission to the private genomes. MylIMG annotations on public genomes are not
restricted.

e The user can only view, but not modify, MyIMG annotations by other group members.

To view MyIMG annotations by group members, click the "View Group Annotations" button in
the IMG User Annotations page shown in Figure 1.1. Many IMG users have used this feature for
group annotations with colleagues.

MyIMG annotations are private by default. However, IMG users can change any of their MyIMG
annotations to public. Public MyIMG annotations are visible to all IMG users provided that users
have access permissions to the corresponding genomes. Public MyIMG annotations on public
genomes can be viewed by all users.
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3 Missing Genes

The review of genes and their functional annotations may lead to the identification of missing

genes.

3.1 Using Artemis to Find Missing Genes

After determining that a gene x of a genome G is missing because of a similar gene, x’in a

closely related genome G’, you can use Artemis ? to fill in the missing gene as follows:

1. Pick the sequence for gene x’ from and run TBLASTn against genome G where you want to
find the missing gene.
2. If you get a TBLASTN hit, copy part of the sequence and paste it into the Artemis navigator

in the box labeled "Find Amino Acid String", as illustrated in Figure 3.1(i). The navigator is

under the "Go to" menu. Then click on the "Goto" button.

3. The amino acid sequence is now highlighted, as illustrated in Figure 3.1(ii). Go to the
"Create" menu and select "Create feature from base range", as illustrated in Figure 3.1(iii).
4. To extend the gene, go to the "Edit' menu and select "Extend to next stop codon", then

select "Fix stop codons".

Artemis Navigator

Goto Base:
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Goto

Goto Feature With Gene Name:
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String:

® Start search at beginning (or end)
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12



Figure 3.1. Using Artemis to define a missing gene.

5. Tofind the 5' end, under the "Edit" menu, click on "Extend to previous stop codon" (you can
also use Control-Q for this), as illustrated in Figure 3.2(i).

6.

To get the amino acid sequence, go to the View menu and select "View amino acid
sequence as FASTA". BLAST the sequence against NCBI or IMG. Based on the aligned

sequences, find where the start codon should be, as illustrated in Figure3.2 (ii).

Select the start codon by pressing "Control-Y". "Control-Y" moves the 5' end to the next

potential start codon, as illustrated in Figure 3.2(iii).
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Figure 3.2. Using Artemis to define a missing gene (cont.).

3.2 Viewing and Adding Missing Genes into IMG

After users identify missing genes in certain genomes, they can add missing genes into IMG. In
the IMG User Annotations page (Figure 1.1), there is a View My Missing Gene Annotations

section. Click the "View My Missing Genes" button to view all your missing genes (Figure 3.3(i)).
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My Missing Gene Annotations (i)

Select Taxon Display Name Count

1 Hyperthermus butylicus DSM 5456 [A][F] 2
1 Methanococcoides burtonii DSM 6242 [A][F] | 1

My Gene Detail

View Missing Gene Annotations (III)
Gene Information

Vv Gene Information
— ) Gene ID M43
My Missing Gene Annotations for S¢ | gene symbol

Locus Type CDs
Filter column: Genome Name = Filter fext = :
Locus Tag test
Page 1of 1 1 (1-=4)-alpha-D-glucan branching enzyme/(1->4)-alpha-D-glucan synthase (ADP-glucose)
Column Selector | Select Page H Deselect Page Na
- Hyperthermus butylicus DSM 5456
Select Genome Mame =~ Missing Gene ID e}
NA Coordinates «2000..2300,3000._>3500 (+)(802bp) -- partial gene

Scaffold Source Hyperthermus butylicus DSM 5456: NC_008818
Hyperthermus b
butylicus DSM @ 3 Is Public? No
D

5456 [A][F Protein Information

Amino Acid Sequence Length|| 267aa
Hyperthermus

butylicus DSM 622 | te
5456 [A][F

Methanococcoides

burtonii DSM 6242 227 | tRNA-Trp NC_007955 175851176049 + No
[A)F]

Page 1of 1 1 All -

Update Missing Gene Annotation Delete Missing Gene Annotation Add Missing Gene Annotation Add/Update IMG Term(s)

HEUT_00Te

(ii)

Figure 3.3. View My Missing Genes

Click "View Missing Gene Annotations" in My Missing Gene Annotations page will show a list
of existing missing genes (Figure 3.3(ii)). Click on a specific Missing Gene ID will lead to the My
Gene Detail page of that missing gene (Figure 3.3(iii)).

To add a missing gene, click the "Add Missing Gene Annotations" button to select the target
genome, and then click the "Select to Add My Missing Gene" button.

A user can define the following properties of a missing gene:
e Product Name (required)
o Locus Type (required): CDS, tRNA, rRNA, miscRNA, or misc_feature
e Locus Tag (required)
e EC number: for enzyme(s)
e Scaffold
o DNA Coordinates (required):

o Use comma to separate DNA coordinate ranges; e.g., 3146..3680,5982..8922
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o Use '<'or ">'to indicate DNA coordinates in partial gene; e.g., <1..30,25..>75
e Strand: + or -
e |s Pseudo Genes? Yes or No
e Description
o Gene Symbol
¢ Hit Gene ID: if gene has any hits
e |s Public? Yes or No

e Replacing Gene(s): existing genes on the same scaffold to be replaced by this new
missing gene

New Missing Gene Annotation

Q ‘ (1) Fields with (%) are required.
(2) Use comma to separate DNA coordinate ranges; e.g., 3146..3680,5982..8922
(3) Use '<'or =" fo indicafe DNA coordinates in partial gene; e.g., <1..30,25..>75
(4) Missing genes with |s Public?' set to Yes will be visible to all users, and may be modified by JGI
experts.
(5) If this missing gene is replacing one or more existing genes, enter Gene OlD(s) in the ‘Replacing
Gene(s)' field (comma delimifed)

Adguiflexum balticum BA160. DSM 16 B

My Missing Gene Neighborhood x
Product Name (*) hypothetical
Locus Type (%) CDS My Gene Id: 0
Locus Tag (*) Aquba_3556 | Start Coord. 4139895
EC Number End Coord. 4144045

Strand. +
Scaffold Aguba Con
DNA Coordinates ()| 4138895 414 4116072 4121972 4126872 4181972 4136972 4141872 1146972 4151972 4156372 4161972
Strand .. aa 1T <d O e el
Is Pseudo Gene?

RS red = Current Gene

Description cyan or dashes = My Gene

white = Pseudo Gene
Gene Symbol

ni CRISPR array
Hit Gene ID
Is Public?
Replacing Gene(s)

View Neighborhood Add My Missing Gene Annotation

Figure 3.4. Adding New Missing Gene Annotation

The "View Neighborhood" button in the New Missing Gene Annotation page enables users to
graphically view the new missing gene on the selected scaffold in My Missing Gene
Neighborhood popup (Figure 3.4).

Users can also add IMG terms to the missing genes. To add or update IMG terms of a missing
gene, first select the missing gene in the My Missing Annotations for Selected Genomes
window (Figure 3.3 (ii)) and then click the "Add/Update IMG Term(s)" button. Select proper IMG
term(s), and then click the "Update Term Association" button to update.
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3.3 Community Missing Gene Annotations in IMG

Missing gene annotations are private by default. A user can change his/her missing gene
annotations to public. Public missing gene annotations are visible to all users who have access
permission to the corresponding genomes. Moreover, since IMG ER is an "Expert Review" site,
all public missing gene annotations can be reviewed and modified by JGI experts.

Aquiflexum balticum BA160, DSM 16537 (j)
Add to Genome Cart E7 Browse Genome 1% BLAST G B Data
About Genome
o Overiew
o Statistics
o Genes
Overview All Public Missing Gene Annotations for Selected Genomes (ii)
Proposal Name Filter column: IMG Contact T Fitter text < [ hopy | @
Organism Name Page 10f 1 1 All -
Taxon 1D
Column Selector
IMG Submission ID
NCBI Taxon ID Genome Name IMG Contact ~  Missing Gene ID Gene Product Name Locus Type Locus Tag Scaffold DNA
GOLD ID in IMG Databd Aquiflexum
; ‘ ;
External Links w %gcsh%"ﬂﬁm':k@ﬂ‘s . 759 hypothetical protein cDS Aquba 3566 Aquba_Contigds1 = 4139895 4142}
Genome Type BIF ’ -
I;neage. S Aquiflexum
equencing Status B

MG Relonse w %g:gh%"ﬂﬁm’:k@ﬂ‘s - 750  hypothetical protein cDs Aquba 4317 Aquba Contig381 = 5045483 5044}
Comment BIIF]
Rel Date TTTUTT
Add Date 2011-07-19 f

Mumber of Chromosomal Cassettes 51 -

All Public Missing Genes -

Fused Protein coding genes 42 0.82%

Protein coding genes coding signal peptides 546 10.67%

Figure 3.5. View Public Missing Genes from Genome Detail page.

If there are any public missing genes defined in a genome, in the Genome Statistics table of
the Genome Detail page, there is "All Public Missing Genes" with count (see Figure 3.5 (i)).
Click on the count will show a list of all public missing genes with additional information.

Public missing genes can be added into the IMG database after JGI expert review. After the
database update, those public missing genes will become official genes in IMG.
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